	5
	Enhancing Your Presentation with Multimedia


Overview

This chapter covers PowerPoint’s multimedia features. Students will learn to apply various movement effects; insert sound, music, and movie files; and record and playback narration.
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Pre Test/ Post Test—Chapter 5
Fill in the Blank

1. _____ are the special effects you see when you go from one slide to the next. 
2. A ____________ is a connection that lets you branch to other slides within the same slideshow.
3. To select more than one slide in the Slides tab, hold down the _____ key while clicking on the thumbnail of each slide. 
4. __________ _____________ gives you total control in how each object appears on the slide.
5. The simplest way to insert a hyperlink is to type it in as_________.
6. _________ _________ resemble VCR-like controls used to navigate to different slides.

7. Short exerts of sound, music, and movie elements are called ___________.
8. If a sound clip is less that 100 Kb, it is ________ into your presentation.
9. Sound clips in PowerPoint can be configured to play automatically upon displaying a slide, or played ________ in a continuous loop. 
10. Television-quality video displays approximately _____ frames per second.
Multiple Choice
11. PowerPoint presentations can be enhanced with which of the following?
A. animations
B. transitions
C. timings
D. sound
E. all of the above
12. The movements you see when you go from one slide to the next are called a(n)
A. animation effects
B. transition effects
C. hyperlink effects
D. custom movements
13. Animation effects in a PowerPoint presentation are used to
A. entertain your audience
B. distract your audience
C. focus your audience’s attention on important points
D. A and C
E. none of the above
14. In which task pane can you add effects that appear on slides?
A. Animation Movements
B. Custom Transitions
C. Custom Animation
D. Add Effects

15. To configure a sound clip to play in a continuous loop in a presentation you would need to use which dialog box?
A. Sound Option dialog box
B. Media dialog box
C. Audio dialog box
D. none of the above
16. Which is not a motion path?
A. Down
B. Left 
C. Diagonal right
D. Spiral
17. When you type in an HTML address, how does it appear on the slide?
A. circled
B. as a cyberlink
C. as a hyperlink
D. it will not appear on the slide
18. To insert Action buttons choose
A. AutoShape, action buttons, choose the buttons
B. Insert, buttons
C. Format, action button, insert button
D. none of the above
19. How can a sound file be added to a presentation?
A. embedded
B. linked
C. attached
D. both A and B
20. Which is not a movie option?
A. Zoom to full screen
B. Mute
C. Hide while not playing
D. Loop until stopped
True/ False

21. ___Animation is the movement from slide to slide.
22. ___Only one transition can be applied to and entire presentation.
23. ___To make an object move along a motion path click the Go button.
24. ___A hyperlink allows you to link presentations together.
25. ___Action buttons can be used to navigate through a presentation.
26. ___Sound can only be played in a presentation when the icon is clicked.
27. ___Sound clips are inserted as icons on slides in PowerPoint.
28. ___When recording narration and you need to interrupt your recording, right click and choose: pause narration.
29. ___The .avi file format can be played from within PowerPoint
30. ___A movie is usually played on the full-size screen.
Teaching Tips and Lecture Notes
Multimedia effects can add interest to a presentation and make it more meaningful to your audience. Using these effects skillfully takes some practice and can add complexity to your presentation. Care must be taken to make sure your presentation displays correctly on the computer used to project. Depending on how computers are configured, they handle media files differently. 

For presentations that are distributed on a CD or the Web or (covered in Chapters 7 and 8), recorded narration could be an essential part of a presentation when an audience views it at different times and in different locations instead of using PowerPoint to support a “live” presentation. A presenter could record the audio that a viewer will hear when he or she goes through the presentation.

In this lesson, we begin with adding movement and interaction. Section 2 covers the use of sound and music. Section 3 covers inserting movie clips. 
Section 5.1 Adding Movement and Interaction
This section covers the application of transition effects (between slides), custom animation (on slides), and preset animation schemes. Effects can be applied to individual slides or to all slides in a presentation. Once students learn the procedures for applying these effects, they should consider carefully how and why the effects should be applied. Some effects, for example, are similar to turning pages of a book and are subtle in that they simply help an audience tell that slides are changing. Other effects can be more dramatic and specifically planned to accentuate the entrance or exit of a slide object. Keep in mind that movements should be logical.
While students are learning about these effects, encourage them to experiment and try out many different effect combinations. Students usually enjoy working with animations and you may need to remind them to apply it selectively when they are creating their own presentations for classroom assignments. Remember that if everything moves, then the movement has no impact. Movement on key presentation elements draws attention.
Hyperlinks allow movement to different slides, presentations, or Web sites. They can also be used to create menu-based presentations. Hyperlinks can be controlled by text links, Action buttons, or from an image. 

Section 5.1.1 Adding Slide Transition Effects
Concept:
Applying a transition to one or more selected slides

Method:
To apply a transition between slides, select the desired slides from the Slides tab.  Hold down the Ctrl key when selecting more than one slide.  After the selection of slides is complete, choose the Slide Transition menu item from the Slide Show menu.  Then, click a transition effect from the list in the Slide Transition task pane.

To modify the speed of the transition or sound played during the transition, use the drop-down lists in the Modify Transition area of the task pane.  Additionally, you can modify when the transition occurs by using the controls in the Advance Slide area of the task pane.

Notes:
When selecting transitions for individual slides, choose a movement that enhances the slide content or calls more attention to it. For example, you might use Box Out when a picture is in the middle of a slide.
Concept:
Applying a transition to all slides in a presentation

Method:
To set a single transition style for all of the slides in a presentation, choose the Slide Transition menu item from the Slide Show menu.  Then, click a transition effect from the list in the Slide Transition task pane.  Specify transition options in the Modify Transition and Advance Slide areas (as specified above), and click the Apply to All Slides button to complete the application of the transition.

Notes:
Transitions can serve a purpose similar to turning pages in a book. It is generally best to use one movement type for your whole presentation and apply other selected ones to emphasize the content of selected slides. You want your audience to focus on the content of your message and not be distracted by wondering what effect will be used next.
Section 5.1.2 Applying Animation Schemes
Concept:
Applying animation schemes to one or more selected slides

Method:
To apply an animation scheme to a slide or group of selected slides, select the slides using the Slides tab.  Hold down the Ctrl key to select more than one slide.  Then, choose the Animation Schemes menu item from the Slide Show menu.  Next, click an Animation Scheme from the Slide Design task pane.  The selected animation will be applied to each of the selected slides.

Notes:
None.

Concept:
Applying animation schemes to all slides in a presentation

Method:
To apply an animation scheme to all of the slides in a presentation, choose the Animation Schemes menu item from the Slide Show menu.  Then, click an animation scheme from the Slide Design task pane and click the Apply to All Slides button in the task pane.  The selected animation will be applied to all of the slides of the presentation.

Notes:
Once a scheme is selected, it can be modified.
Section 5.1.3 Applying Custom Animation

Concept: 
Applying custom animation to slide objects
Method:
Select the object on a slide and click Slide Show, Custom Animation. Click the Add Effect button on the Custom Animation task pane, to choose from Entrance, Exit, Emphasis, and Motion Path effects. At the bottom of the first list that appears, click More Effects to see the entire listing of all available movement effects. They are organized by Basic, Subtle, Moderate, and Exiting. You can preview each effect as it is applied.
Notes:
Be sure the movements are logical and make sense for the particular slide content. It is easy for students to get “carried away” and make everything move. One place to observe how movements can be skillfully applied is on television news programs. Watch the weather and sports presentations and observe how the television screens change.

A complex diagram can benefit by animation because you can add each part of the diagram as you explain it. Chart content can be emphasized by using chart animation to add data by series or by category. You might have situations where automating the animation is helpful instead of clicking the mouse to activate every movement. Using the Effects options to add sound when a slide object appears is an effective way to add sound. 
Section 5.1.4 Creating Hyperlinks
Concept:
Inserting text hyperlinks into a presentation

Method:
Hyperlinks can be inserted into a presentation’s slides to ease the process of opening a web page during a presentation.  Web URLs and email addresses can be typed as ordinary text when authoring a slide and PowerPoint will convert them automatically into hyperlinks.

Hyperlinks can be edited so that the URL or email address is replaced by other text, yet the text maintains the properties of a link.  In addition to the steps in the text, you can select the existing URL or email address and click the Insert Hyperlink button on the Standard toolbar.  Next, edit the Text to display: field in the Insert Hyperlink dialog window that appears, and ensure that the Address: text area is correctly filled in with the intended URL.  Finally, click the OK button to change the text to a link.

Notes:
The Insert Hyperlinks dialog window can also be displayed by choosing the Hyperlink menu item from the Insert menu.  The dialog window supports the creation of new hyperlinks, the editing of existing hyperlinks, and the management of links to in-presentation locations.

Section 5.1.5 Using Action Buttons and Images for Hyperlinks

Concept: 
Using Action Buttons for linking
Method:
In the Drawing toolbar, click AutoShapes, Action Buttons, then choose the appropriate button such as Forward or Next. The Action settings dialog box will automatically appear. You can also choose the Slide Show menu, Action Buttons, and choose the appropriate button. You can set up the link to be on mouse click or on mouse over.
Notes:
The icons on these buttons are universally recognizable so they can be used effectively within self-guided presentations. They will appear in a color controlled by your design template’s color scheme; this color can be changed if you wish. Students will learn to customize color schemes in Chapter 6.
Concept: 
Using Images for Hyperlinks
Method:
Select an image and choose the Slide Show menu, Action Settings, and then choose the action for on mouse click or on mouse over.
Notes:
This technique is not automatically recognizable to your audience, so it provides you with a subtle way to link to another slide, presentation, or Web page. However, you could create a shape to purposely look like a button for self-guided presentations.
Section 5.2 Adding Sounds and Music
Sound can grab attention, entertain, or simply complement a presentation. Sound can be audio recordings, music clips, or music played from CDs.
Section 5.2.1 Inserting Sound and Music Clips

Concept:
Inserting sound clips for audio or music
Method:
Sound clips (audio or music) can be inserted from any file or from the Clip Organizer.  Once inserted, sound clips can be played when a slide is displayed or when a user clicks on a sound icon.

To insert a sound clip, choose the Movies and Sound menu item from the Insert menu.  Then, perform one of the following:

· To insert a clip from a file, choose the Sound from File menu item.  Use the dialog window that appears to navigate the file system and locate the desired sound clip.  Double-click on the file’s icon to insert it into the slide.

· To insert a clip from the Clip Organizer, choose the Sound from Clip Organizer menu item and click on the desired sound clip from the Clip Organizer task pane. 

Next, click the Yes button in the question dialog window that appears to automatically play the sound clip each time the slide is displayed.  Clicking the No button will insert an icon into the slide.  When the icon is clicked during a presentation, the sound clip will be played.

Notes:
Use the Custom Animation task pane to access Effect Options where you can set more characteristics for how the sound will play. For example, you could have music start playing after a certain number of seconds or play while several slides display when you set a stop playing action after a particular slide number.
Section 5.2.2 Recording Narration

Concept: 
Recording narration to add an audio explanation of slide content
Method:
Choose Slide Show, Record Narration. (Usually you will be asked to test the current recording quality of your computer system.) As you advance through the slide show, talk into your microphone to record your voice. What you say while each slide is displayed will be recorded and saved with the presentation.
Notes:
This feature could be very important to presentations distributed on CDs or on the Web as self-guided presentations. However, using this feature could also be a good practice tool for rehearsing a presentation. Playing back the recording would enable you to critique voice qualities and enunciation. Then before a “live” delivery of the presentation, the narration could be removed.
Section 5.2.3 Playing Music from CDs
Concept: 
Playing music from CDs
Method:
Choose Insert, Movies and Sounds, Play CD Audio Track. Set sound options for looping, track, beginning/ending seconds.
Notes:
Looping causes the music to repeat; track enables you to select a particular track on the CD, beginning/ending seconds controls the precise segment of a particular track. Just as for other sounds, you can use the Effect Options in the Custom Animation task pane to control additional settings. For example, you could have the music play while several different slides are displayed.
Section 5.3 Showing Movie Clips

This section focuses on inserting movies that are already created. A movie can be an animated .gif file (a series of graphics that appear to move) or video clips. When you search through Microsoft’s sound files through the Clip Art task pane, many of the ones that appear are animated .gif files or what can be referred to as “event” sounds such as a door closing. Sometimes files that are music recordings appear, too.
Video files could be used very effectively if you have the equipment to capture the video in a digital format or convert it to a digital format. For example, someone who could not be present at a meeting could record his or her comments for playback through the slide show during the meeting. 
Section 5.3.1 Inserting Movie Clips from Clip Organizer

Concept: 
Inserting a movie from Microsoft’s Clip Organizer
Method:
Choose Insert, Movies and Sounds, Movie from Clip Organizer. The Clip Art task pane will appear and you should select the movie media type from the Results should be box.
Notes:
Animated .gif files are often intended to be funny, so you might find a clip that would add just the right touch of humor to your presentation. Generally these images cannot be resized to be larger because they become distorted.
Section 5.3.2 Inserting Movie Clips from Files

Concept: 
Inserting a prerecorded movie clip from a file
Method:
Choose Insert, Movies and Sounds, Movie from File. Navigate to the location where your file is stored to select the file name. Then choose how you want the movie to start in the slide show as either automatically or when clicked. If you choose when clicked, then the movie will appear as a picture on the slide until you mouse over it and click to activate it.
Notes:
If you right-click the movie (shown on the slide as the first frame that looks like a picture), you can choose options for looping, rewinding, hiding, or zooming to full screen. Zoom to full screen is a wonderful effect, but the movie may look distorted depending on the size and resolution of the original version.
Pre Test/Post Test Answers

	
	Fill in the Blanks
	Multiple Choice
	True/False

	
	1. transitions (5.1:PP 208)
2. hyperlink (5.1:PP 208)
3. Ctrl (5.1.1:PP 209)
4. Custom animation (5.1.3:PP 212)
5. text (5.1.4:PP 218)  
6. Action buttons (5.1.5:PP 219)
7. clips (5.2:PP 222)
8. embedded (5.2.1:PP 223)
9. repeatedly (5.2.1:PP 223)
10. 30 (5.3:PP 230)

	11. E (5.1:PP 208)
12. B (5.1.1:PP 208)
13. D (5.1.2:PP 210) 

14. C (5.2:PP 222)
15. A (5.1.3:PP 212)
16. D (5.1.3:PP 212)
17. C (5.1.3:PP 212)
18. A (5.1.5:PP 219)
19. C (5.2.1:PP 223)
20. B (5.3.2:PP 232)

	21. F (5.1:PP 208)

22. F (5.1.1:PP 209)
23. F (5.1.3:PP 212)

24. T (5.1.4:PP 218)

25. T (5.1.5:PP 219)

26. F (5.2.1:PP 223)

27. T (5.2.1:PP 223)

28. T (5.2.2:PP 226)

29. T (5.3:PP 230)

30. F (5.3.2:PP 232)




Self Check Question Answers
1. A slide transition is the movement from slide to slide as each slide enters and exits display on your screen.
2. Transitions can be added to slides individually or as a group. Use the Slide tab to select the slides you want to have a transition effect, choose Slide Show, Slide Transition, and then choose the type of movement you want. 
3. Animation schemes are preset movements that affect placeholders and sometimes transitions. To set an animation scheme, first select the slides to which you want to apply the scheme, then choose Slide Show, Animation Schemes. Choose your effect from the categories of effects for Subtle, Moderate, and Exciting.

4. The purpose of a hyperlink is to connect to other slides within a slideshow, a different slideshow, or a Web site. This feature enables branching such as for menu selections instead of the more traditional linear flow of a presentation.

5. To create a hyperlink using Action Buttons, choose AutoShapes, Action Buttons, then the Forward or Next button. Drag to create a button. As soon as you release your mouse, the Action Settings dialog box will appear and you can select the destination (other slide, slideshow, or Web site) where you want to link.

6. To search for a sound clip based on a typed keyword, choose Insert, Movies and Sounds and your Clip Art task pane will appear. At the top of the pane you can enter your keyword in the Search for box. Before activating the search, be sure a check is in front of sound (not other media types) in the Results should be box. 

7. Sound can be associated with animation effect that you apply to an object on the slide. With the object selected, choose Slide Show, Custom Animation, then Effects Options to control the effect, timing, and sound settings.

8. When a sound icon has been inserted on a slide, to play the sound in Slide Show view you simply click on the sound icon while that slide is displayed. 

9. Recording narration with your slideshow requires a sound card, speakers, and microphone installed on your computer. Then in PowerPoint, go to the slide where you want the recording. Choose Insert, Movies and Sounds, Record Sound. Click the record button when you are ready to begin and then click the stop button when you are finished. The audio recording is automatically associated with that slide.

10. When you insert a movie, PowerPoint will ask you whether you want it to play automatically when the slide appears or on mouse click. If you want to change this setting later, you can select the movie then right click to bring up the pop-up menu, choose Custom Animation and then Effect Options to make changes.

	True/False 
	Multiple Choice

	1. F

2. T

3. T

4. T

5. F

6. T

7. T

8. F

9. T

10. F
	1. B

2. D

3. C

4. A

5. D

6. C

7. D

8. C

9. A

10. B



Additional Exercises

Activity 1

Assume you are teaching a group of students how to find information on the Internet about buying a car. Go to www.edmunds.com and look for tips and advice about purchasing. Also check www.autobuytel.com. Prepare a presentation with several slides to explain the type of information these sites provide and to recommend how to use these sites. Include hyperlinks to the sites to demonstrate some content from the site during your presentation. Save two or more images from the sites to use in your presentation (right-click on the image and then from the pop-up menu choose Save As and save it in your personal storage location). Be sure to credit the image source as well as any text that you quote.
Activity 2

Collect some personal photographs to scan and arrange in a presentation. Perhaps you have photographs from a wedding. Or perhaps you would like to show pictures for a birthday celebration and feature photographs of the person being honored. Scan these photographs and then insert them in a presentation. Select an appropriate song from a CD and set it to play while all slides are displayed during an automated slide show.
Activity 3

Search on the Internet for a movie trailer, pictures, and sounds clips that can be downloaded that interests you. Movie sounds and quotations are featured at www.moviesounds.com.  For a classroom presentation situation, select the clips carefully because some of them may not be appropriate to use because of the inappropriate language or connotation of the quote. Create a presentation to feature the media files you located and “tell the story” of the movie. If a movie trailer cannot be downloaded, then prepare a hyperlink to go to that Web site and play the movie from the necessary link on that site.
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